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Introduction to Novell Cluster Services

Novell® Cluster ServicesTM is a server clustering system that ensures high 
availability and manageability of critical network resources including data 
(volumes), applications, server licenses, and services. It is a multinode, 
eDirectoryTM enabled clustering product for NetWare® 6 that supports 
failover, failback, and migration (load balancing) of individually managed 
cluster resources.

Documentation Conventions
In this documentation, a greater-than symbol (>) is used to separate actions 
within a step and items in a cross-reference path.

Also, a trademark symbol (®, TM, etc.) denotes a Novell trademark. An asterisk 
(*) denotes a third-party trademark.
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1 Overview

Novell® Cluster ServicesTM is a server clustering system that ensures high 
availability and manageability of critical network resources including data 
(volumes), applications, server licenses, and services. It is a multinode 
clustering product for NetWare® that is enabled for eDirectoryTM and supports 
failover, failback, and migration (load balancing) of individually managed 
cluster resources.

Licenses for two cluster nodes is included with NetWare 6. Licenses for 
additional cluster nodes may be purchased separately.

Product Features
Novell Cluster Services includes several important features to help you ensure 
and manage the availability of your network resources. These include:

Support for shared SCSI or fiber channel storage area networks.

Multinode all-active cluster (up to 32 nodes). Any NetWare server in the 
cluster can restart resources (applications, services, IP addresses, and 
volumes) from a failed server in the cluster.

Single point of administration through a browser-based NetWare Remote 
ManagerTM or a Java-based ConsoleOneTM cluster configuration and 
monitoring GUI. The browser-based NetWare Remote Manager lets you 
remotely manage your cluster.

The ability to tailor a cluster to the specific applications and hardware 
infrastructure that fit your organization.
Overview 9
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Dynamic assignment and reassignment of server storage on an as-needed 
basis.

The ability to automatically notify administrators through e-mail of 
cluster events and cluster state changes.

Product Benefits
Novell Cluster Services allows you to configure up to 32 NetWare servers into 
a high-availability cluster, where resources can be dynamically switched or 
moved to any server in the cluster. Resources can be configured to 
automatically switch or be moved in the event of a server failure, or can be 
moved manually to troubleshoot hardware or balance the workload.

Novell Cluster Services provides high availability from commodity 
components. Lower costs are obtained through the consolidation of 
applications and operations onto a cluster. The ability to manage a cluster from 
a single point of control and to adjust resources to meet changing workload 
requirements (thus, manually “load balance” the cluster) are also important 
benefits of Novell Cluster Services.

An equally important benefit of implementing Novell Cluster Services is that 
you can reduce unplanned service outages and reduce planned outages for 
software and hardware maintenance and upgrades.

Reasons you would want to implement Novell Cluster Services include:

Increased availability

Improved performance

Low cost of operation

Scalability

Disaster recovery

Data protection

Shared resources

Shared disk fault tolerance can be obtained by implementing RAID Level 5 
on the shared disk subsystem.
10   Novell Cluster Services Overview and Installation
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An example of the benefits Novell Cluster Services provides can be better 
understood through the following scenario.

Suppose you have configured a three-server cluster, with a Web server 
installed on each of the three servers in the cluster. Each of the servers in the 
cluster hosts two Web sites. All the data, graphics, and e-mail messages for 
each Web site is stored on a shared disk subsystem connected to each of the 
servers in the cluster. The following figure depicts how this setup might look.

Figure 1 Three-Server Cluster

During normal cluster operation, each server is in constant communication 
with the other servers in the cluster and performs periodic polling of all 
registered resources to detect failure. 

Suppose Web Server 1 experiences hardware or software problems and the 
users depending on Web Server 1 for Internet access, e-mail, and information 
lose their connections. The following figure shows how resources are moved 
when Web Server 1 fails.

Web Server 3

Web Site C

Web Site D

Web Server 2

Fiber Channel Switch

Shared Disk
System

Web Site E

Web Site F

Web Site A

Web Site B

Web Server 1
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Figure 2 Three-Server Cluster after One Server Fails

Web Site A moves to Web Server 2 and Web Site B moves to Web Server 3. 
IP addresses and applicable licenses also move to Web Server 2 and Web 
Server 3.

When you configured the cluster, you decided where the Web sites hosted on 
each Web server would go should a failure occur. In the previous example, you 
configured Web Site A to move to Web Server 2 and Web Site B to move to 
Web Server 3. This way, the workload once handled by Web Server 1 is evenly 
distributed.

When Web Server 1 failed, Novell Cluster Services software

Detected a failure.

Remounted the shared data volumes (that were formerly mounted on Web 
server 1) on Web Server 2 and Web Server 3 as specified.

Restarted applications (that were running on Web Server 1) on Web 
Server 2 and Web Server 3 as specified.

Transferred IP addresses to Web Server 2 and Web Server 3 as specified.

In this example, the failover process happened quickly and users regained 
access to the Internet, Web site information, and e-mail within seconds, and in 

Web Server 1
Web Server 3

Web Site A

Web Site C

Web Site D

Web Server 2

Fiber Channel Switch

Shared Disk
System

Web Site B

Web Site E

Web Site F
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Now suppose the problems with Web Server 1 are resolved, and Web Server 
1 is returned to a normal operating state. Web Site A and Web Site B will 
automatically failback, or be moved back to Web Server 1, and Web Server 
operation will return back to the way it was before Web Server 1 failed.

Novell Cluster Services also provides resource migration capabilities. You can 
move applications, Web sites, etc. to other servers in your cluster without 
waiting for a server to fail.

For example, you could have manually moved Web Site A or Web Site B from 
Web Server 1 to either of the other servers in the cluster. You might want to do 
this to upgrade or perform scheduled maintenance on Web Server 1, or just to 
increase performance or accessibility of the Web sites.

Cluster Configuration
Typical cluster configurations normally include a shared disk subsystem 
connected to all servers in the cluster. The shared disk subsystem can be 
connected via high-speed fiber channel cards, cables, and switches, or be 
configured to use shared SCSI. If a server fails, another designated server in 
the cluster automatically mounts the shared disk volumes previously mounted 
on the failed server. This gives network users continuous access to the 
volumes on the shared disk subsystem.

Typical resources might include data (volumes), applications, server licenses, 
and services. The following figure shows how a typical fiber channel cluster 
configuration might look.
Overview 13
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Figure 3 Typical Fiber Channel Cluster Configuration

Although fiber channel is the recommended configuration, you can configure 
your cluster to use shared SCSI. The following figure shows how a typical 
shared SCSI cluster configuration might look.

Sys Sys Sys Sys Sys Sys

Server 1 Server 2 Server 3 Server 4 Server 5 Server 6

Fiber Channel Switch

Shared Disk
System

Network Hub

Fiber 
Channel
Card(s)

Network
Interface
Card(s)
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Figure 4 Typical Shared SCSI Cluster Configuration

Cluster Components
The following components make up a Novell Cluster Services cluster:

From 2 to 32 NetWare servers configured to use IP, each containing at 
least one local disk device (used for a local SYS: volume).

Novell Cluster Services software running on each NetWare server in the 
cluster.

A shared disk subsystem connected to all servers in the cluster (optional, 
but recommended for most configurations).

High-speed fiber channel cards, cables, and switch or SCSI cards and 
cables used to connect the servers to the shared disk subsystem.

Sys Sys

Server 1 Server 2

Shared Disk
System

Network Hub

SCSI
Adapter

SCSI
Adapter

Network
Interface

Card

Network
Interface

Card
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2 Installation and Setup

Hardware Requirements
The following list specifies hardware requirements for installing Novell® 
Cluster ServicesTM. These requirements represent the minimum hardware 
configuration. Additional hardware might be necessary depending on how 
you intend to use Novell Cluster Services.

A minimum of two NetWare® servers

At least 256 MB of memory on all servers in the cluster (512 MB 
recommended for failing multiple applications to the same server)

At least one local disk device (not shared) for volume SYS: on each server

Software Requirements
You must have NetWare 6 running on each cluster server. Ensure the 
following requirements are met:

All servers in the cluster configured with the IP protocol and on the same 
IP subnet

An additional IP address for the cluster and each cluster resource and 
cluster-enabled volume

All servers in the cluster in the same eDirectoryTM tree
Installation and Setup 17
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Shared Disk System Requirements
A shared disk system (Storage Area Network or SAN) is required for each 
cluster if you want data to be highly available. If a shared disk subsystem is 
used, ensure the following:

At least 15 MB of free disk space on the shared disk system for creating 
a special cluster partition

The Novell Cluster Services installation automatically allocates one 
cylinder on one drive of the shared disk system for the special cluster 
partition. Depending on the location of the cylinder, the actual amount of 
space used by the cluster partition may be less than 15 MB.

The shared disk system is properly set up and functional according to the 
manufacturer’s instructions

Prior to installation, verify that all the drives in your shared disk system 
are recognized by NetWare by running the LIST DEVICES command on 
each server you intend to add to your cluster. If any of the drives in the 
shared disk system do not show up in the list, consult your NetWare 
documentation or the shared disk system documentation for 
troubleshooting information.

The disks contained in the shared disk system are configured in a 
mirroring or RAID 5 configuration to add fault tolerance to the shared 
disk system
WARNING: If the disks in the shared disk system are not configured to use 
mirroring or RAID 5, a single disk error can cause a volume failure. Novell Cluster 
Services software will not protect against such faults.

Rules for Operating a Novell Cluster Services SAN
When you create a Novell Cluster Services system that utilizes shared storage 
space (a Storage Area Network or SAN), it is important to remember that all 
servers attached to the shared device, whether in the cluster or not, have access 
to all of the volumes on the shared storage space unless you specifically 
prevent such access. Novell Cluster Services arbitrates access to shared 
volumes for all cluster nodes, but cannot protect shared volumes from being 
corrupted by noncluster servers.

When working with shared storage, do not attach a noncluster server to the 
18   Novell Cluster Services Overview and Installation
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that the noncluster server has access only to its own volumes. Failure to do so 
will result in data corruption or volume loss.

Installing or Upgrading Novell Cluster Services
It is necessary to run the Novell Cluster Services installation program when 
you 

Create a new cluster

Add new nodes to an existing cluster

Upgrade Novell Cluster Services software in an existing cluster

If you are running the Novell Cluster Services installation program to create a 
new cluster, the program automatically

Creates a new Cluster object in eDirectory

Installs Novell Cluster Services software on the servers you specify to be 
part of your cluster

After running the Novell Cluster Services installation the first time to create a 
new cluster, you will need to run the Novell Cluster Services installation again 
each time you want to add new servers to your cluster or upgrade Novell 
Cluster Services software on an existing cluster. 

Novell Cluster Services Licensing
Novell Cluster Services requires a Cluster Server License for each server that 
is part of the cluster. The Cluster Server License allows a server to join a 
cluster. Cluster Server License objects are created in the same eDirectory 
context as the Cluster object.

Cluster Server Licenses for a two-node cluster are already provided with 
NetWare 6 and are automatically added during the Novell Cluster Services 
installation. You only need additional Cluster Server Licenses if you have a 
three-node or larger cluster. Additional Cluster Server Licenses can be 
obtained from Novell or from your Novell Authorized ResellerSM.

Previous versions of Cluster Services required a Cluster User Access License 
(CUAL). NetWare 6 now uses User Access Licensing, which elimates the 
need for a CUAL.
Installation and Setup 19
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Prepare Cluster Servers for an Upgrade
If you are upgrading Novell Cluster Services from a previous version and your 
cluster has shared storage, you must prepare your cluster servers before 
upgrading them to NetWare 6 and before upgrading Novell Cluster Services. 
This preparation is necessary to ensure existing shared-volume trustee 
assignments can be used after the upgrade.

To prepare cluster servers for an upgrade, from a NetWare client run 
NWDEPLOY.EXE from the root of the NetWare 6 Operating System CD to 
launch the NetWare Deployment Manager, and then complete the following 
steps:

1 In the NetWare Deployment Manager, open the Network Preparation 
Folder and click Prepare a Novell Cluster for Upgrade.

Continue through the screens until you get to the screen that prompts you 
to select an existing cluster to prepare for upgrade.

2 Specify the cluster name, eDirectory tree, and context for the cluster you 
are preparing for upgrade.

3 Choose whether you want the servers you are going to upgrade to go 
down after completing the preparation for upgrading cluster servers. Then 
click Next to run the program for preparing cluster servers for upgrade.

Bringing down all cluster servers before an upgrade ensures NSS 
volumes on shared storage (your SAN) are deactivated prior to upgrading 
to NetWare 6. 

If you choose to not bring down all cluster servers after completing the 
preparation for upgrading cluster servers, you must do it manually before 
upgrading cluster servers to NetWare 6.

Once you have completed the process for preparing cluster servers for upgrade 
and upgrading those servers to NetWare 6, continue with the instructions in 
“Run the Installation Program” on page 20.

Run the Installation Program
To install Novell Cluster Services, insert the NetWare 6 Operating System CD 
in a NetWare client workstation and allow the NetWare Deployment Manager 
to automatically launch. You can also run NWDEPLOY.EXE from the root of 
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the CD to launch the NetWare Deployment Manager. After starting the 
NetWare Deployment Manager, complete the following steps:
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1 In the NetWare Deployment Manager, open the Post-Installation Tasks 
folder and click Install or Upgrade a Novell Cluster.

Continue through the installation screens until you get to the screen that 
prompts you to create a new cluster, add new nodes to an existing cluster, 
or upgrade software in an existing cluster.

2 Click Create a New Cluster, Add New Nodes to Existing Cluster, or 
Upgrade Software in Existing Cluster, and then click Next.

The Skip File Copy check box is checked by default and prevents Novell 
Cluster Services files from being copied during the installation. The 
NetWare 6 installation program automatically copies all Novell Cluster 
Services files to every NetWare 6 server. If you want to refresh Novell 
Cluster Services files on cluster servers you should uncheck the Skip File 
Copy check box. Even though Novell Cluster Services files already exist 
on each NetWare 6 server, you still need to run the Novell Cluster 
Services installation program to configure and set up cluster nodes.

Leaving the Skip File Copy check box unchecked will cause existing 
Novell Cluster Services files to be copied over, but will not otherwise 
affect the installation.

3 Do one of the following:

(If creating) Enter the name for the new Cluster object you are 
creating and specify the Directory tree and context where you want 
it created. Then click Next and continue with Step 4 on page 21.
NOTE: Do not use periods in cluster names. NetWare and NetWare clients 
interpret a period as a delimiter.

(If adding new nodes) Specify the eDirectory tree, context, and name 
of the cluster you will add servers to. If you don’t know a cluster 
name or its context, browse and select one. Then click Next and 
continue with Step 4 on page 21.

(If upgrading software) Specify the Directory tree, context, and name 
of the cluster where software will be upgraded. Then click Next and 
go to Step 7 on page 22.

4 Enter the name of the server you want to add to the cluster, or browse and 
select one from the list, and then click Add to Cluster. Repeat this step for 
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every server you want to add to the cluster. Then click Next.
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You can also remove servers you just added to the cluster by selecting 
them from the NetWare Servers in Cluster list and clicking Remove.

When you add a server to a cluster, Novell Cluster Services automatically 
detects the server’s IP address. If the server you are adding has more than 
one IP address, you will be prompted to select the IP address you want 
Novell Cluster Services to use.

5 Enter a uniqe IP address for the cluster.

The cluster IP address is separate from the server IP address and is 
required for certain external network management programs to get cluster 
status alerts. The cluster IP address provides a single point of cluster 
access for NetWare Remote Manager. A Master IP Address resource is 
created automatically during the Cluster Services installation that makes 
this possible.

The cluster IP address will be bound to the master node and will remain 
with the master node regardless of which server is the master node.

6 (Conditional) If you are creating a new cluster, specify whether your 
cluster has a shared disk system and, if so, select the drive where you want 
the small cluster partition created. Then click Next.

Novell Cluster Services requires a small cluster partition on the shared 
disk system. You are also given the option of mirroring the partition for 
greater fault tolerance.
IMPORTANT: You must have at least 10 MB of free space that is not part of an 
NSS partition on one of the shared disk drives to create the cluster partition. If no 
free space is available, the shared disk drives can’t be used by Novell Cluster 
Services.

If you previously installed Novell Cluster Services and created a cluster 
with the same name, the installation program will detect that a cluster 
partition has already been created and this screen will not appear.

7 Choose whether or not you want the servers you are upgrading or adding 
to your cluster to start Novell Cluster Services software after the 
installation. Then click Next.

If you choose to not start Novell Cluster Services software on each server 
22   Novell Cluster Services Overview and Installation

Novell Cluster Services Overview and Installation

March 6, 2003
Novell Confidential

that you upgrade or add to your cluster, you will need to manually start it 
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after the installation or you will need to reboot cluster servers to 
automatically start it.

You can manually start Novell Cluster Services by running LDNCS at the 
server console on each cluster server.

If you are installing or upgrading a two-node cluster or not adding 
additional nodes to a two-node cluster, continue with Step 9 on page 23.

8 (Conditional) Specify the location of the Cluster Server License files or 
browse and select a path, then click Add.

Since licenses for a two-node cluster are included with NetWare 6, this 
screen only appears if you are installing or upgrading a three-node or 
larger cluster.

If you are installing a three-node or larger cluster, you can obtain 
additional Cluster Server Licenses from Novell or from your Novell 
Authorized Reseller.

You are given the option of installing without licenses. If you choose to 
install without licenses and you have a cluster with more than two nodes, 
you will need to manually install the licenses at a later date using 
iManage. If you install licenses at a later date, after installing the licenses 
you must reboot each cluster server that you have added a license to. This 
will ensure that cluster licensing functions properly. Novell Cluster 
Services will not function without the proper licenses in place.

9 Continue through the final installation screen.

If you are creating a new cluster, the installation program will create 
a new Cluster object in eDirectory and install Novell Cluster 
Services software on the servers you specified to be part of your 
cluster.

If you are adding new nodes to an existing cluster, the installation 
program will install Novell Cluster Services software on the servers 
you are adding to your cluster.

If you are upgrading Novell Cluster Services software on an existing 
cluster, the installation program will upgrade cluster software on all 
servers in the cluster.
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Setting Up Novell Cluster Services
If you created a new cluster, you now need to create and configure cluster 
resources. You might also need to create shared disk partitions if they do not 
already exist and, if necessary, configure all shared disk system pools and 
volumes to work with Novell Cluster Services. You might also need to cluster 
enable the shared disk system pools and volumes.

While ConsoleOne is the recommended tool for creating shared disk 
partitions, NSS pools, and volumes, NetWare Remote Manager can also be 
used.

Create Shared Disk Partitions
Before creating disk partitions on shared storage (storage area network or 
SAN), Novell Cluster Services must be installed. You should carefully plan 
how you want to configure your shared storage prior to installing Novell 
Cluster Services.

Using ConsoleOne

1 Start ConsoleOne and authenticate to the eDirectory tree where the 
Cluster object resides.

ConsoleOne runs faster on a client than a server. From a NetWare client, 
go to the SYS:PUBLIC\MGMT\CONSOLEONE\1.2\BIN directory on a 
server in the cluster and run CONSOLEONE.EXE. 

We recommend running ConsoleOne from the server that is your primary 
NetWare connection.

2 In the left pane, right-click the Cluster object or the Server object of a 
server in the cluster and then click Properties.

3 On the Media tab, click Devices and then select the Device where you 
want to create the shared partition. Ensure the Sharable for Clustering 
check box is checked for the device.

If a device is marked as sharable, all partitions on that device will 
automatically be sharable.

Device names are not changeable and might be labeled something like 
0x2 or 0x1.

If Cluster Services was previously installed and shared disk partitions 
24   Novell Cluster Services Overview and Installation

Novell Cluster Services Overview and Installation

March 6, 2003
Novell Confidential

were already created, the Partitions List field will include this 
information.



Manual December 10, 200289
4 On the Media tab, click Partitions >New, and then select the device where 
you want to create the partition (the same device you selected in the 
previous step).

5 Specify the size of the partition and click OK to create it.

Continue with “Create NSS Pools” on page 27.

On this screen you should also ensure NSS is selected as the partition type 
(this is the default) and ensure the Hot FixTM and Mirror check boxes are 
checked and that Create New Mirror Group is selected.

In NetWare Remote Manager, the process for creating a shared disk partition 
is also used to create an NSS pool, and volume. NetWare Remote Manager 
will create the partition, NSS Pool, and volume and, if desired, it will also 
cluster enable the NSS pool all at the same time.

Using NetWare Remote Manager

1 In the left column under the Manage Server section, click Volumes.

This is same screen that appears when you start NetWare Remote 
Manager.

2 Under Partition Management, click Disk Partitions.

A screen appears displaying a list of devices that are currently accessible 
to servers in the cluster. For each device, the list displays the partitions, 
NSS pools, volumes, and free space on that device.

3 Find the device that corresponds to your shared storage system and click 
Create on the free space where you want to create the partition.

4 Under Novell Storage Services, click Create a New Pool and Volume.

5 Specify the pool size and name, the volume name, and volume attributes.

Because only one pool exists in each partition, the pool size you specify 
will be the size of the partition that gets created. The volume that is 
created will be allowed to grow to the pool size.

6 Choose whether you want the pool to be cluster enabled when it is 
created.

The default is to cluster enable the pool at the time it is created. If you 
want to cluster enable the pool at the same time it is created, leave the 
Cluster Enable Pool check box checked and continue with Step 7 on page 
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If you want to cluster enable the pool at a later date, uncheck the check 
box, click Create, and continue with “Cluster Enable Pools and Volumes” 
on page 30.

7 Specify the Virtual Server Name, Pool IP Address, Advertising Protocols 
and, if necessary, the CIFS Server Name and whether you want the pool 
to be activated upon creation.

When you cluster enable a pool, a virtual Server object is automatically 
created and given the name of the Cluster object plus the cluster-enabled 
pool. For example, if the cluster name is cluster1 and the cluster-enabled 
pool name is pool1, then the default virtual server name will be 
cluster1_pool1_server. You can edit the field to change the default virtual 
server name.

Each cluster-enabled NSS pool requires its own IP address. The IP 
address is used to provide access and failover capability to the cluster 
enabled-pool (virtual server). The IP address you assign to the pool 
remains assigned to the pool regardless of which server in the cluster is 
accessing the pool.

You can select one or all of the advertising protocols. NCPTM is the 
protocol used by Novell clients, CIFS is the protocol used by Microsoft 
clients, and AFP is the protocol used by Macintosh clients. Selecting any 
of the protocols will cause lines to be added to the pool resource load and 
unload scripts to activate the selected protocols on the cluster. This lets 
you ensure that the cluster-enabled pool you just created is highly 
available to all your clients.

If you check the CIFS check box, the CIFS Server Name field will 
become active. The CIFS server name is the server name CIFS clients see 
when they browse the network. A default server name is listed, but you 
can change the server name by editing the text in the field.

The Auto Pool Activate check box is used to determine if the pool you are 
creating is to be activated as soon as it is created. The Auto Pool Activate 
check box is checked by default. If you uncheck the check box, you will 
have to manualy activate the pool later before it can be used.

8 Click Create to create the partition, NSS pool, and volume and to cluster 
enable the NSS pool.
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Create NSS Pools
The new Storage Pools feature in NSS gives you more flexibility in planning 
and configuring your storage to work with Novell Cluster Services. More than 
one cluster-enabled volume can now be part of a single cluster resource, and 
volumes can dynamically grow as needed to take advantage of free disk space.

Only one NSS pool can be created on a partition. Storage pools can be cluster 
enabled at the same time they are created or they can be cluster enabled at a 
later time after they are created. To learn more about NSS pools, see Creating 
a Storage Pool in the Novell Storage Services Administration Guide.

Using ConsoleOne

1 In ConsoleOne, on the property page of the Server object, click the Media 
Tab and select NSS pools.

2 Click New, specify the name and type of pool you want to create, and then 
click Next.

ZLSS is the default pool (LSS) type and should be the type used with 
Novell Cluster Services.

3 Select the partition you just created and then click Next.

4 Choose whether you want the pool to be activated and cluster enabled 
when it is created.

The Activate on Creation check box is checked by default. This will cause 
the pool to be activated as soon as it is created. If you uncheck the check 
box, you will have to manually activate the pool later before it can be 
used.

The Cluster Enable on Creation check box is also checked by default. If 
you want to cluster enable the pool at the same time it is created, leave the 
check box checked and continue with Step 5 on page 27. If you want to 
cluster enable the pool at a later date, uncheck the check box, click Finish, 
and continue with “Create Cluster Volumes” on page 29. 

5 Specify the Virtual Server Name, IP Address, Advertising Protocols and, 
if necessary, the CIFS Server Name.

When you cluster enable a pool, a virtual Server object is automatically 
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pool. For example, if the cluster name is cluster1 and the cluster-enabled 
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pool name is pool1, then the default virtual server name will be 
cluster1_pool1_server. You can edit the field to change the default virtual 
server name.

Each cluster-enabled NSS pool requires its own IP address. The IP 
address is used to provide access and failover capability to the cluster-
enabled pool (virtual server). The IP address you assign to the pool 
remains assigned to the pool regardless of which server in the cluster is 
accessing the pool.

You can select one or all of the advertising protocols. NCP is the protocol 
used by Novell clients, CIFS is the protocol used by Microsoft clients, 
and AFP is the protocol used by Macintosh clients. Selecting any of the 
protocols will cause lines to be added to the pool resource load and unload 
scripts to activate the selected protocols on the cluster. This lets you 
ensure that the cluster enabled pool you just created is highly available to 
all your clients.

If you check the CIFS check box, the CIFS Server Name field will 
become active. The CIFS server name is the server name CIFS clients see 
when they browse the network. A default server name is listed, but you 
can change the server name by editing the text in the field.

6 Click Finish to create and cluster enable the pool.

Depending on your network configuration and the size of your eDirectory 
tree, it could take a while for the pool information to be updated in 
eDirectory. You can ensure the pool information is updated immediately 
in eDirectory by selecting the pool from the pools list under the Media tab 
and then clicking Update NDS.

Repeat the above steps for each additional pool you want to create on 
shared storage.

Continue with “Create Cluster Volumes” on page 29.

Using NetWare Remote Manager

The same procedure for creating shared disk partitions using NetWare Remote 
Manager is used to create NSS pools. To create an NSS pool on shared storage 
using NetWare Remote Manager go to Step 1 on page 25.
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Create Cluster Volumes
If you plan on using a shared disk system in your cluster and need to create 
new NetWare pools or volumes after installing Novell Cluster Services, the 
server used to create the volumes should already have NSS installed and 
running. NSS is the default file system for NetWare 6.

Using ConsoleOne

1 In ConsoleOne, on the property page of the Server object, click the Media 
tab and select NSS Logical Volumes.

2 Click New, enter the name of the volume you want to create, and then 
click Next.

Each shared volume in the cluster must have a unique name.

3 Select the pool where you want the volume to reside and either enter a 
quota for the volume or check the check box to allow the volume to grow 
to the pool size. Then click Next.

The quota is the maximum possible size of the volume. If you have more 
than one volume per pool, you should enter a quota for each volume 
rather than allowing multiple volumes to grow to the pool size.

If you attempt to create a volume on shared storage without first creating 
a pool, or you choose a shared partition to create the volume on instead of 
a pool you will be prompted to specify clustering information for a pool 
that will be automatically created for you by Novell Cluster Services. See 
Step 5 on page 27 for details on the information you will be required to 
supply.

4 Review and change volume attributes as necessary, and then click Finish 
to create the volume.

You might want to check the Flush Files Immediately check box. This 
will help ensure the integrity of volume data. Checking the Flush Files 
Immediately check box will improve file system reliability but will 
hamper performance. You should consider this option only if necessary.

Depending on your network configuration and the size of you eDirectory 
tree, it could take a while for the voume information to be updated in 
eDirectory. You can ensure the volume information is updated 
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5 Repeat the above steps for each cluster volume you want to create.

Depending on your configuration, the new volumes will either mount 
automatically when resources that require them start or will have to be 
mounted manually on individual servers after they are up.
IMPORTANT: If you have a volume that is not being managed by Novell Cluster 
Services, the volume will need to be mounted before you can access it. The MOUNT 
ALL command in AUTOEXEC.NCF will no longer mount all NSS volumes by default. In 
the AUTOEXEC.NCF file of the server where the volume is to be mounted, add 
separate MOUNT commands followed by the volume name for each of the noncluster 
volumes you want to mount.

Using NetWare Remote Manager

The same procedure for creating shared disk partitions using NetWare Remote 
Manager is used to create cluster volumes. To create a cluster volume on 
shared storage using NetWare Remote Manager go to Step 1 on page 25.

Cluster Enable Pools and Volumes
If you have a shared disk system that is part of your cluster and you want the 
pools and volumes on the shared disk system to be highly available to 
NetWare clients, you will need to cluster enable those pools and volumes. 
Cluster enabling a pool or volume allows it to be moved or mounted on 
different servers in the cluster in a manner that supports transparent client 
reconnect.

With this release of Cluster Services, cluster-enabled volumes no longer 
appear as cluster resources. NSS pools are resources, and load and unload 
scripts apply to pools and are automatically generated for them. Each cluster-
enabled NSS pool requires its own IP address. This means that each cluster-
enabled volume does not have an associated load and unload script or an 
assigned IP address.

NSS pools can be cluster enabled at the same time they are created. If you did 
not cluster enable a pool at creation time, the first volume you cluster enable 
in the pool automatically cluster enables the pool where the volume resides. 
Once a pool has been cluster enabled, you will need to cluster enable the other 
volumes in the pool if you want them to be mounted on another server during 
a failover. 
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When a server fails, any cluster-enabled pools being accessed by that server 
will fail over to other servers in the cluster. Because the cluster-enabled pool 
fails over, all volumes in the pool will also fail over, but only the volumes that 
have been cluster enabled will be mounted. Any volumes in the pool that have 
not been cluster enabled will have to be mounted manually. For this reason, 
volumes that aren’t cluster enabled should be in separate pools that are not 
cluster enabled.

If you want each cluster-enabled volume to be its own cluster resource, each 
volume must have its own pool.

Some server applications don’t require NetWare client access to volumes, so 
cluster enabling pools and volumes might not be necessary. Pools should be 
deactivated and volumes should be dismounted before being cluster enabled.

Using ConsoleOne

1 Browse and select the Cluster object.

2 Click File > New > Cluster > Cluster Volume.

3 Browse and select a volume on the shared disk system to cluster enable.

4 Enter an IP address for the volume.

This is only required for the first volume to be cluster enabled in the pool. 
This IP address will be assigned to the pool where the volume resides.

Checking the Online Resource after Create check box will cause the 
volume to automatically mount once it is created.

5 (Optional) Change the default name of the virtual Server object.

When you cluster enable a pool, a virtual Server object is automatically 
created and given the name of the Cluster object plus the cluster-enabled 
pool. For example, if the cluster name is cluster1 and the cluster-enabled 
pool name is pool1, then the default virtual server name will be 
cluster1_pool1_server.

If you are cluster enabling a volume in a pool that has already been cluster 
enabled, the virtual Server object has already been created, and you can’t 
change the virtual Server object name.

6 (Optional) Change the default name of the cluster-enabled Volume object.
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When you cluster enable a volume, a new object is automatically created 
and given the name of the Cluster object and the volume name. For 
example, if the cluster name is cluster1 and the volume name is vol1, then 
the default cluster-enabled Volume object name will be cluster1_vol1.

7 Ensure the Define Additional Properties check box is checked, click 
Create and then continue with “Set Start, Failover, and Failback Modes” 
on page 37.

Using NetWare Remote Manager

1 In NetWare Remote Manager, in the left column under the Clustering 
section, select Cluster Config.

2 At the bottom of the screen under Create New Objects, click New Cluster 
Volume.

3 Select the volume you created in the previous section and click Select.

4 Enter the IP address you want to assign to the cluster-enabled volume.

All other fields on this screen should be automatically updated. You can 
change or edit the information in the fields as desired. See Step 5 on page 
31 and Step 6 on page 31 for more information.

This is only required for the first volume to be cluster enabled in the pool. 
This IP address will be assigned to the pool where the volume resides.

Checking the Auto-Online check box will cause the resource to 
automatically start once it is created.

5 Click the Save button to create the volume resource and then continue 
with “Set Start, Failover, and Failback Modes” on page 37.

When the volume resource is brought online, the pool will automatically be 
activated. You don’t need to activate the pool at the server console.

If you delete a cluster-enabled volume, Novell Cluster Services will 
automatically remove the volume mount command from the resource load 
script. If you delete a cluster-enabled pool, Novell Cluster Services will 
automatically remove the pool resource object and the virtual server object 
from eDirectory. If you rename a cluster-enabled pool, Novell Cluster 
Services will automatically update the pool resource load and unload scripts 
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Create Cluster Resource Templates
Templates simplify the process of creating similar or identical cluster 
resources. For example, templates are helpful when you want to create 
multiple instances of the same resource on different servers. You can create 
templates for any server application or resource you want to add to your 
cluster.

Novell Cluster Services currently provides templates for DHCP, GroupWise®, 
and NetWare Enterprise Web Server, as well as a generic IP SERVICE 
template. The generic IP SERVICE template can be used when configuring 
certain server applications to run on your cluster. You can edit and customize 
any of the templates for your specific needs.

Using ConsoleOne

1 Browse and select the Cluster object where you want to create a cluster 
resource template.

2 From the menu bar, click File > New > Cluster > Cluster Resource.

3 Enter a name for the new cluster resource template.

4 Check the Create Resource Template check box.

This option lets you create a cluster resource template instead of a cluster 
resource.

5 Check the Define Additional Properties check box, and then continue 
with “Configure Load Scripts” on page 35.

To finish creating a cluster resource template, you need to configure load 
and unload scripts, set failover and failback modes and, if necessary, 
change the node assignments for the resource template.

Using NetWare Remote Manager

1 On the left column under the Clustering section, click Cluster Config.

2 At the bottom of the screen above Create New Objects, click New Cluster 
Resource.

3 Enter a name for the new cluster resource template.
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4 Check the Create Resource and the Define Additional Properties check 
boxes and then click Apply.
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5 Continue with “Configure Load Scripts” on page 35.

Create Cluster Resources
Cluster resources must be created for every resource or application you run on 
servers in your cluster. Cluster resources can include Web sites, e-mail servers, 
databases, and any other server-based applications or services you want to 
make available to users at all times.

Using ConsoleOne

1 Browse and select the Cluster object you want to create resources for.

2 Click File > New > Cluster > Cluster Resource.

3 Enter a name for the new cluster resource.
IMPORTANT: Do not use periods in cluster resource names. NetWare and 
NetWare clients interpret a period as a delimiter.

4 If a template exists for the resource you are creating, enter the template 
name in the Inherit From Template field, or browse and select it from the 
list. If a template does not exist, check the Define Additional Properties 
check box.

5 (Conditional) Check the Online Resource after Create check box if you 
want the resource to automatically start on the master node as soon as it 
is created and configured.

6 Click Create.

7 (Conditional) If you are not using a template for the resources, continue 
with “Configure Load Scripts” on page 35.

Using NetWare Remote Manager

1 On the left column under the Clustering section, click Cluster Config.

2 At the bottom of the screen under Create New Objects, click New Cluster 
Resource.

3 Enter a name for the new cluster resource.

4 If a template exists for the resource you are creating, select it from the list 
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and then click Apply. If a template does not exist, check the Define 
Additional Properties check box and then click Apply.
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The default selection for this field is No Template.

5 (Conditional) If you are not using a template for the resource, continue 
with “Configure Load Scripts” on page 35.

If you are not using a template, you must complete the process for creating the 
cluster resource by configuring load and unload scripts, setting failover and 
failback modes and, if necessary, changing the node assignments for the 
resource.

If you are using a template for this resource, additional resource configuration 
is performed automatically by the template.

More information on configuring GroupWise, NDPS®, NetWare Enterprise 
Web Server and many other applications is available at Novell’s 
documentation Web site (http://www.novell.com/documentation/lg/ncs6p/
index.html).

Configure Load Scripts
A load script is required for each resource, service, or disk pool in your cluster. 
The load script specifies the commands to start the resource or service on a 
server, or to mount the volume on a server. 

You can use any commands in the load script that would be used in a .NCF file 
run from the server console. If you don’t know which commands to add to 
your load script, consult the documentation for the application or resource.

Load scripts are automatically created for disk pools when you cluster enable 
them. Because of this, it might not be necessary to configure or change the 
load script for a pool.

Using ConsoleOne

1 Select the Load Script tab on the resource property page.

2 Edit or add the necessary commands to the script to load the resource on 
the server.

Some commands may require command line input. You can add << to a 
command to indicate command line input. For example, a script 
command might read

LOAD SLPDA <<Y

This means that when SLPDA is loaded, it will receive a Y at the 
command line, presumably to a question that needs a Yes answer. If more 
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LOAD SLPDA <<Y

<<Y

<<N

The string can be up to 32 characters.

3 Specify a timeout value.

The default is 600 seconds, or 10 minutes. The timeout value determines 
how much time the script is given to complete. If the script does not 
complete within the specified time, the resource becomes comatose.

Using NetWare Remote Manager

1 On the left column under the Clustering section, click Cluster Config.

2 From the list of Resources, select the desired resource or resource 
template.

3 On the Resource Information screen, click Loading.

4 Edit or add the necessary commands to the script to load the resource on 
the server.

For more details on load script commands see the instructions above on 
configuring load scripts using ConsoleOne.

5 Specify the Load Timeout and click Apply to save the script.

This is the same as the timeout value described in the above instructions 
on configuring load scripts using ConsoleOne.

Configure Unload Scripts
Depending on your cluster application or resource, you can add an unload 
script to specify how the application or resource should terminate. An unload 
script is not required by all resources or applications, but it can ensure that 
during a failback or manual migration, a resource unloads before it loads on 
another node. Consult your application vendor or documentation to determine 
if you should add commands to unload the resource.

Unload scripts are automatically created for disk pools when you cluster 
enable them. Because of this it might not be necessary to configure or change 
the load script for a pool.

Using ConsoleOne
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1 Select the Unload Script tab on the resource property page.
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2 Edit or add the necessary commands to the script to unload the intended 
resource on the server.

You can use any commands used in a .NCF file run from the server 
console. If you don’t know which commands to add, consult the 
documentation for the application or resource you want to unload.

3 Specify a timeout value and click Apply to save the script.

The default is 600 seconds, or 10 minutes. The timeout value determines 
how much time the script is given to complete. If the script does not 
complete within the specified time, the resource becomes comatose.

Using NetWare Remote Manager

1 On the left column under the Clustering section, click Cluster Config.

2 From the list of Resources, select the desired resource.

3 On the Resource Information screen, click Unloading.

4 Edit or add the necessary commands to the script to unload the intended 
resource on the server.

5 Specify the Load Wait Time and click Apply to save the script.

Set Start, Failover, and Failback Modes
You can configure the start, failover, and failback of cluster resources to 
happen manually or automatically. With the resource Start Mode set to AUTO, 
the resource automatically starts on a server when the cluster is first brought 
up. If the resource Start Mode is set to MANUAL, you can manually start the 
resource on a server when you want, instead of having it automatically start 
when servers in the cluster are brought up. 

With the resource Failover Mode set to AUTO, the resource automatically 
starts on the next server in the Assigned Nodes list in the event of a hardware 
or software failure. If the resource Failover Mode is set to MANUAL, you can 
intervene after a failure occurs and before the resource is moved to another 
node.

With the resource Failback Mode set to DISABLE, the resource does not fail 
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automatically fails back to its most preferred node when the most preferred 
node rejoins the cluster. Set the resource Failback Mode to MANUAL to 
prevent the resource from moving back to its preferred node when that node 
is brought back online, until you are ready to allow it to happen.

The preferred node is the first server in the list of the assigned nodes for the 
resource.

Using ConsoleOne

1 In ConsoleOne, right click the resource object and select Properties, then 
select the Policies tab on the property page.

2 (Conditional) Check the Ignore Quorum check box if you don’t want the 
cluster-wide timeout period and node number limit enforced. 

The quorum default values were set when you installed Novell Cluster 
Services. You can change the quorum default values by accessing the 
properties page for the Cluster object. 

Checking this box will ensure the resource is launched immediately on 
any server in the Assigned Nodes list as soon as any server in the list is 
brought online.

3 Choose the Start, Failover, and Failback modes for this resource. 

The default for both Start and Failover modes is AUTO, and the default 
for Failback mode is DISABLE.

4 Check the Master Only check box to ensure the resource runs only on the 
master node in the cluster.

If the master node in the cluster fails, the resource will fail over to 
whichever node becomes the master.

5 Click Apply to save changes.

Using NetWare Remote Manager

1 On the left column under the Clustering section, click Cluster Config.

2 From the list of Resources, select the desired resource.

3 On the Resource Information screen, click Policies.
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4 Check or uncheck the Ignore Quorum check box as desired.
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See the instructions above on setting resource Start, Failover, and 
Failback modes using ConsoleOne for more details.

5 Select the Start, Failover, and Failback modes for this resource.

6 Check or uncheck the Master Only check box.

If the Master Only box is checked, the resource will run only on the server 
designated as the Master node in the cluster.

7 Click Apply.

Assign Nodes to a Resource
When you create a resource on a cluster or cluster enable a volume or pool, 
the nodes in the cluster are automatically assigned to the resource or the 
volume or pool. The order of assignment is the order the nodes appear in the 
resource list. You can assign or unassign nodes to the resource or the volume 
or pool, or change the failover order.

Using ConsoleOne

1 Select the Nodes tab on the resource property page.

2 From the list of unassigned nodes, select the server you want the resource 
assigned to and click the Right-arrow button to move the selected server 
to the Assigned Nodes list. 

Repeat this step for all servers you want assigned to the resource. You can 
also use the Left-arrow button to unassign servers from the resource.

3 Click the Up- and Down-arrow buttons to change the failover order of the 
servers assigned to the resource or volume.

4 Click Apply to save node assignment changes.

Using NetWare Remote Manager

1 On the left column under the Clustering section, click Cluster Config.

2 From the list of Resources, select the desired resource.

3 On the Resource Information screen, click Nodes.
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4 Select or type in the nodes that you want assigned to this resource.

5 Click Apply to save node assignment changes.
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Configuration Settings
Depending on your needs and cluster setup, some additional configuration 
may be required for you to effectively use Novell Cluster Services. This 
additional configuration might consist of changing the values on some of the 
properties for the Cluster object and the Cluster Node objects.

Edit Quorum Membership and Timeout Properties
You can edit Quorum Membership and Timeout properties using either 
ConsoleOne or NetWare Remote Manager.

Using ConsoleOne

1 Right-click the Cluster object.

2 Click Properties. 

3 Select the Quorum tab on the Cluster Object Property page.

Using NetWare Remote Manager

1 On the left column under the Clustering section, click Cluster Config.

2 Select the Cluster object name.

3 Click Quorum.

Membership

The Quorum Membership is the number of nodes that must be running in the 
cluster before resources will start to load. When you first bring up servers in 
your cluster, Novell Cluster Services reads the number specified in the 
Membership field and waits until that number of servers is up and running in 
the cluster before it starts loading resources. 

Set the Membership value to a number greater than 1 so that all resources 
don’t automatically load on the first server that is brought up in the cluster. For 
example, if you set the Membership value to 4, there must be four servers up 
in the cluster before any resource will load and start.
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Timeout

Timeout specifies the amount of time to wait for the number of servers defined 
in the Membership field to be up and running. If the timeout period elapses 
before the quorum membership reaches its specified number, resources will 
automatically start loading on the servers that are currently up and running in 
the cluster. For example, if you specify a Membership value of 4 and a timeout 
value equal to 30 seconds, and after 30 seconds only two servers are up and 
running in the cluster, resources will begin to load on the two servers that are 
up and running in the cluster.

Cluster Protocol Properties
You can use the Cluster Protocol property pages to view or edit the transmit 
frequency and tolerance settings for all nodes in the cluster, including the 
master node. The master node is generally the first node brought online in the 
cluster, but if that node fails, any of the other nodes in the cluster can become 
the master.

Using ConsoleOne

1 Right-click the Cluster object.

2 Click Properties.

3 On the Cluster Object property page, select the Protocol tab.

This tab has two pages: Settings and Internals. The Internals page lets you 
view the script used to configure the cluster protocol settings, but not 
change it. Use the Settings page to make changes to cluster protocol 
properties.

Using NetWare Remote Manager

1 On the left column under the Clustering section, click Cluster Config.

2 Select the Cluster object name.

3 Click Protocol.

Heartbeat

Heartbeat specifies the amount of time between transmits for all nodes in the 
cluster except the master. For example, if you set this value to 1, nonmaster 
nodes in the cluster send a signal that they are alive to the master node every 
second.
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Tolerance

Tolerance specifies the amount of time the master node gives all other nodes 
in the cluster to signal that they are alive. For example, setting this value to 4 
means that if the master node does not receive an “I’m alive” signal from a 
node in the cluster within four seconds, that node is removed from the cluster.

Master Watchdog

Master Watchdog specifies the amount of time between transmits for the 
master node in the cluster. For example, if you set this value to 1, the master 
node in the cluster transmits an “I’m alive” signal to all the other nodes in the 
cluster every second.

Slave Watchdog

Slave Watchdog specifies the amount of time the master node has to signal that 
it is alive. For example, setting this value to 5 means that if the nonmaster 
nodes in the cluster do not receive an “I’m alive” signal from the master within 
five seconds, the master node is removed from the cluster and one of the other 
nodes becomes the master node.

Max Retransmits

This option is not currently used with Novell Cluster Services but will be used 
for future versions.

Cluster IP Address and Port Properties
The Cluster IP address is assigned when you install Novell Cluster Services. 
The Cluster IP address normally does need to be changed, but can be if 
needed.

The default cluster port number is 7023, and is automatically assigned when 
the cluster is created. The cluster port number does not need to be changed 
unless a conflict is created by another resource using the same port number. If 
there is a port number conflict, change the Port number to any other value that 
doesn’t cause a conflict.
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Using ConsoleOne

1 Right-click the cluster object.

2 Click Properties.

3 On the Cluster Object property page, select the Management tab.

Using NetWare Remote Manager

1 On the left column under the Clustering section, click Cluster Config.

2 Select the Cluster object name.

3 Click IP Address.

Resource Priority
The Resource Priority allows you to control the order in which multiple 
resources start on a given node when the cluster is brought up or during a 
failover or failback. For example, if a node fails and two resources fail over to 
another node, the resource priority determines which resource loads first.

This is useful for ensuring that the most critical resources load first and are 
available to users before less critical resources.

Uusing ConsoleOne

1 Right-click the cluster object.

2 Click Properties.

3 On the Cluster Object property page, select the Resource Priority tab.

4 To change the priority for a resource, select the resource in the list and 
then click the Increase or Decrease button to move the resource up or 
down in the list.

This lets you change the load order of the resource relative to other cluster 
resources on the same node.

You can also select a resource and then click the Selected button to reset 
the resource back to its default load order.

5 Click the Apply button to save changes made to resource priorities.

Using NetWare Remote Manager

1 On the left column under the Clustering section, click Cluster Config.
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3 Click Resource Priorities.

4 To change the priority for a resource, assign it a number between 0 and 
65535.

65535 is the maximum value and 0 is the minimum value. Setting a 
resource priority to 65535 ensures the resource loads before other 
resources with lower priority settings. Setting the resource priority to 0 
ensures the resource loads last after all other resources have loaded. The 
default resource priority setting is 0.

If you assign multiple resources the same priority, the start order of those 
resources is random.

5 Click the Apply button to save changes made to resource priorities.

Cluster E-Mail Notification
Novell Cluster Services can automatically send out e-mail messages for 
certain cluster events like cluster and resource state changes or nodes joining 
or leaving the cluster.

In order for cluster e-mail notification to work, you must first configure e-mail 
notification for server health status using NetWare Remote Manager. For 
instructions on how to do this go to Diagnosing Server Problems (http://
www.novell.com/documentation/lg/nw6p/index.html?page=/documentation/
lg/nw6p/port_enu/data/ab1mxn5.html) and find the section on Configuring E-
mail Notification for Server Health Status.

You can enable or disable e-mail notification for the cluster and specify up to 
eight administrator e-mail addresses for cluster notification.
IMPORTANT: If you add or delete an administrator e-mail address or change the type 
of cluster events you want administrators to receive messages for (verbose to XML, 
etc.), you must reload CMA.NLM (the Cluster Management Agent) on all servers in the 
cluster for the changes to take effect.

Using ConsoleOne

1 Right-click the cluster object

2 Click Properties.
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3 On the Cluster Object property page, select the Notification tab.
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4 Check or uncheck the Enable Cluster Notification Events check box to 
enable or disable e-mail notification.

5 If you enable e-mail notification, add the desired e-mail address in the 
field provided and click the button next to the field to add the address to 
the list. Repeat this process for each address you want on the notification 
list.

It is not necessary to add quotes to e-mail address names.

6 If you enable e-mail notification, specify the type of cluster events you 
want administrators to receive messages for.

To only receive notification of critical events like a node failure or a 
resource going comatose, check the Receive Only Critical Events check 
box .

To receive notification of all cluster state changes including critical 
events, resource state changes, and nodes joining and leaving the cluster, 
check the Verbose Messages check box. 

To receive notification of all cluster state changes in XML format, check 
the XML Messages option. XML format messages can be interpreted and 
formated with a parser that lets you customize the message information 
for your specific needs.

7 Click the Apply button to save changes made.

Using NetWare Remote Manager

1 On the left column under the Clustering section, click Cluster Config.

2 Select the Cluster object name and click Email Reporting.

3 Add the desired email addresses in the fields provided.

It is not necessary to add quotes to e-mail address names.

4 Specify the type of cluster events you want administrators to receive 
messages for.

Specify a 1 or a 0 to disable email notification. 

Specify a 2 (Critical) to only receive notification of critical events like a 
node failure or a resource going comatose. 
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Specify a 4 (Verbose) to receive notification of all cluster state changes 
including critical events, resource state changes, and nodes joining and 
leaving the cluster. 

Specify an 8 to receive notification of all cluster state changes in XML 
format. XML format messages can be interpreted and formated with a 
parser that lets you customize the message information for your specific 
needs.

5 Click the Apply button to save your changes.

Cluster Node Properties
You can view or edit the cluster node number or IP address of the selected 
node or view the context for the NetWare Server object.

Using ConsoleOne

1 Select the Cluster object and right-click the desired cluster node on the 
right side of the ConsoleOne display screen.

2 Click Properties.

3 On the Cluster Node property page, select the Node tab.

Using NetWare Remote Manager

1 On the left column under the Clustering section, click Cluster Config.

2 Select the Cluster node name.

3 Click IP Address or Node Number.

(Node) Number+IP Address

Number+IP Address specifies the cluster node number and IP address for the 
selected node. If the cluster node number or IP address changes for the 
selected node, the new information is not automatically updated in eDirectory. 
Edit the information and click Apply to update the information in eDirectory.

NCP Server

The NCP Server field is used to view the context for the NetWare Server 
object. This field cannot be edited.
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Migrating Resources
You can migrate resources to different servers in your cluster without waiting 
for a failure to occur. You might want to migrate resources to lessen the load 
on a specific server, to free up a server so it can be brought down for scheduled 
maintenance, or to increase the performance of the resource or application by 
putting it on a faster machine.

Migrating resources allows you to balance the load and evenly distribute 
applications among the servers in your cluster.

Using ConsoleOne

1 Browse and select the Cluster object that contains the resource you want 
to migrate.

Resources must be in a running state to be migrated.

2 Ensure the right half of ConsoleOne displays the Cluster View State by 
selecting View > Cluster State from the menu at the top of the screen.

3 In the Cluster Resource List, select the resource you want to migrate.

The Cluster Resource Manager screen appears, displaying the server the 
selected resource is currently running on and a list of possible servers to 
which you can migrate resources.

4 Select a server from the list and click Migrate to move the resource to the 
selected server.

Using NetWare Remote Manager

1 On the left column under the Clustering section, click Cluster 
Management.

2 Select the cluster resource you want to migrate.

3 Select a server from the list and then click Migrate to move the resource 
to the selected server.

If you select a resource and click Offline, the resource will be unloaded from 
the server. It will not load on any other servers in the cluster and will remain 
unloaded until you load it again. This option is useful for editing resources 
because resources can’t be edited while loaded or running on a server.
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Identifying Cluster and Resource States
Both the Cluster State view in ConsoleOne and the Cluster Management link 
in NetWare Remote Manager give you important information about the status 
of servers and resources in your cluster. 

Cluster servers and resources display in different colors, depending on their 
operating state. When servers and resources are green, they are in a normal 
operating condition. When a server that has been part of the cluster is red with 
a break in the icon, it has failed. When a resource is red, it is waiting for 
administrator intervention. When a server is gray with no break in the icon, 
that server is not currently a member of the cluster, or its state is unknown. 
When a resource is blank or has no colored icon, it is unassigned, offline, 
changing state, or in the process of loading or unloading.

The yellow ball in the middle of the server icon designates the master server 
in the cluster. The master server is initially the first server in the cluster, but 
another server can become the master if the first server fails.

The Epoch number indicates the number of times the cluster state has 
changed. The cluster state will change every time a server joins or leaves the 
cluster.

Clicking on the Event Log tab in ConsoleOne gives you a detailed history of 
your cluster. Every time the cluster state changes, a new event is added to the 
Event Log. You can sort the events in the log by clicking on the column 
headings of the table. You can reverse the sort order by pressing the Shift key 
while clicking on a column heading. The Event Log is stored on the special 
cluster partition that was created during the Novell Cluster Services 
installation, which ensures it is always available. You can also save the Event 
Log to a file.

Clicking on the HTML Report tab in ConsoleOne in the Cluster State view 
screen launches a more detailed report of the state of your cluster. You can 
view this report or save it to an HTML file for printing or viewing with a 
browser.

The following table identifies the different resource states and gives 
descriptions and possible actions for each state. The possible actions describe 
steps for using ConsoleOne to complete each action. You can also use the 
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Manager, in the left column under the Clustering section, click Cluster 
Management and then select the desired resource.

Resource State Description Possible Actions

Alert Either the Start, Failover, 
or Failback mode for the 
resource has been set to 
Manual. The resource is 
waiting to start, fail over, 
or fail back on the 
specified server.

Click the Alert status 
indicator and depending 
on the resource state, 
you will be prompted to 
Start, Failover, or 
Failback the resource.

Comatose The resource is not 
running properly and 
requires administrator 
intervention.

Click the Comatose 
status indicator and 
offline the resource. 
Once resource problems 
have been resolved, the 
resource can be put back 
online (returned to the 
running state).

Loading The resource is in the 
process of loading on a 
server.

None.

NDS_Sync The properties of the 
resource have changed 
and the changes are still 
being synchronized in 
eDirectory.

None.

Offline Offline status indicates 
the resource is shut 
down or is in a dormant 
or inactive state. 

Click the Offline status 
indicator and if desired, 
click the online button to 
load the resource on the 
best node possible, given 
the current state of the 
cluster and the 
resource’s preferred 
nodes list.
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Additional Cluster Operating Instructions
The following instructions provide additional information for operating 
Novell Cluster Services.

Installing NetWare on a Server That Will Be Added to an Existing 
Cluster

1 Install fiber-channel hardware. 

Quorum Wait The resource is waiting 
for quorum to be 
established so it can 
begin loading.

None.

Running The resource is in a 
normal running state.

Click the Running status 
indicator and choose to 
either migrate the 
resource to a different 
server in your cluster, or 
unload (offline) the 
resource.

Unassigned There isn’t an assigned 
node up that the 
resource can be loaded 
on.

Click the Unassigned 
status indicator and if 
desired, Offline the 
resource. Offlining the 
resource will prevent it 
from running on any of its 
preferred nodes should 
any of them join the 
cluster.

Unloading The resource is in the 
process of unloading 
from the server it was 
running on.

None.

Resource State Description Possible Actions
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installs.
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2 Install NetWare, including the latest Service Pack, on the new server.

3 Reboot the server.

4 Install Novell Cluster Services on the new server.

5 (Conditional) If you have changed the failover order, add the new server 
to the failover list.

By default, Novell Cluster Services will include all nodes on the failover 
list, including newly added nodes.

Readding a Node to a Cluster That Was Prevously in the Cluster
1 If necessary, install NetWare, including the latest service pack on the 

server using the same node name and IP address.

2 If the Cluster object for the server is still present, use ConsoleOne to 
delete the object.

You can do this by going to the Cluster container, selecting the node in the 
right frame, and pressing Delete.

3 Run the Novell Cluster Services installation.

The node will assume its former identity.

Cluster-enabled Volume Connection Required for Some Utilities
Because Novell Cluster Services uses NDS to find objects and resolve names, 
you must first establish a client connection to a cluster-enabled volume for it 
to be visible to certain utilities.

Do this by browsing to and selecting the eDirectory Volume object using 
Windows Explorer.

Some Applications Do Not Fail Over
Although all NetWare 6 applications will run on a cluster node, not all 
applications are capable of being configured as a cluster application and failed 
over to a new node.
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Enabling SNMP Managers to Receive Traps from Cluster Nodes
If you want SNMP managers like ManageWise and Compaq Insight Manager 
to receive traps from cluster nodes, you must manually edit the 
TRAPTARG.CFG file on every server in the cluster and add the IP address of 
the client workstation that will be running the SNMP manager.

1 Using a text editor open the SYS:ETC\TRAPTARG.CFG file on a server 
in the cluster.

2 Add the IP address of the client workstation that will run the SNMP 
manager to the end of the Protocol UDP section of the file.

3 Repeat the above steps for every server in the cluster.

Novell Cluster Services Console Commands
Novell Cluster Services provides several server console commands to help 
you perform certain cluster related tasks. The following table lists the cluster-
related server console commands and gives a brief description of each 
command. To execute a cluster console command type CLUSTER followed by 
the command. For example, if you want to display cluster statistics, type 
CLUSTER STATS DISPLAY at the server console. You can also type HELP 
CLUSTER at the console prompt to get information on the commands and 
their functions.

Cluster Console Command Description

ALERT {resource}{YES/NO} The resource start, failover, or failback mode 
is set to manual and the resource is waiting to 
start on a node, or fail over or fail back to 
another node. Specify the resource name in 
the command and use the YES or NO switch 
to specify whether or not you want the 
resource to fail over, fail back, or start.
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CVSBIND {ADD, DEL}{resource}{IP address} Enables applications that rely on the bindery 
or bindery emulation to access a virtual server 
on the cluster. Specify the resource name for 
the cluster application and the IP address for 
the virtual server. Use the ADD or DEL switch 
to enable or disable bindery access to the 
virutal server.

DHCP {context} Specifies the eDirectory context where DHCP 
configuration information is stored. This 
command is useful if you have problems 
getting DHCP to function properly on a 
cluster.

DOWN Removes all cluster nodes from the cluster. 
Has the same effect as executing the 
CLUSTER LEAVE command on every server 
in the cluster.

JOIN Adds the node where the command is 
executed to the cluster and makes the node 
visible to other servers in the cluster. Cluster 
Services software must already be installed 
on a node for it to join the cluster.

LEAVE Removes the node where the command is 
executed from the cluster. The node will not 
be visible to other servers in the cluster.

MIGRATE {resource}{node name} Migrates the specified resource from the node 
where it is currently running to the node you 
specify in the command. The node you 
migrate the resource to must be running in the 
cluster and also be in the resource’s assigned 
nodes list.

OFFLINE {resource} Unloads the specified resource from the node 
where it is currently running.

ONLINE {resource}{node name} Starts the specified resource on the most 
preferred node that is currently active. You 

Cluster Console Command Description
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POOLS Lists the NSS pools on the shared disk 
system that are accessible by Novell Cluster 
Services.

RESOURCES Lists all resources that currently exist in the 
cluster. The resources do not have to be 
online or running.

RESTART {seconds} Restarts Cluster Services software on all 
servers in the cluster.

STATS {Display, Clear} Reports the node number, node name, and 
heartbeat information. You must switch to the 
log console screen to see cluster statistics.

STATUS {resource} Reports the status of the specified resource. 
This includes the number of times the 
resource has been migrated or failed over to 
another server, the resource state, and the 
node where the resource is currently running.

VIEW Displays the node name, cluster epoch 
number, master node name, and a list of 
nodes that are currently members of the 
cluster.
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